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Interface Configuration

This chapter describes how to configure or set up the interfaces associated with each line card. You can 
configure or set up any interface through the Interface Configuration windows associated with each line 
card.

This chapter contains the following information:

• Interfaces and Related Technology-Specific Windows

• Launching the Interface Configuration Windows

• Generic Interface Configuration

• ATM Interface Configuration

• Ethernet Interface Configuration

• IP Configuration 

• POS Interface Configuration

• APS Interface Configuration

• SRP Interface Configuration

• SRP Side Configuration

Interfaces and Related Technology-Specific Windows
Interfaces on line cards can support multiple technologies. Configuration windows are 
technology-specific. For example, a POS interface supports three configurable technologies: Generic, 
POS, and IP. Therefore, if you want to view or modify the configuration of a POS interface, you might 
need to view three windows:

• Generic Interface Configuration window 

• POS Interface Configuration window

• IP Interface Configuration window

This same process is applicable to all different types of interfaces. Table 8-1 outlines which 
technology-specific configuration windows apply to each interface type.
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Launching the Interface Configuration Windows
I

Note Layer 3 QoS configuration, which includes CAR and WRED, is applicable to all types of interfaces. 
For details on CAR and WRED configuration windows, refer to Chapter 11, “Layer 3 QoS.”

Launching the Interface Configuration Windows
Table 8-2 displays the Interface Configuration windows that can be launched from each object type. For 
example, the ATM Interface Configuration window can be launched from a Site, Shelf, Chassis, Module, 
or ATM Interface object.

Note Commissioning/decommissioning an interface is only available from the Generic Interface 
Configuration window. Refer the “Configuring and Commissioning a Generic Interface” 
section on page 8-4.

Table 8-1 Interfaces and Configuration Windows

Interfaces Technology-Specific Configuration Windows

POS Generic, POS, and IP

ATM Generic, ATM, and IP

Ethernet Generic, Ethernet, and IP

SRP Generic, IP and SRP

SRP Side SRP Side

Table 8-2 Launching the Interface Configuration Windows

C12kM Window/Task

Objects (that can be selected) to Open the 
Window

Menu Options to Select to Open WindowSite Shelf Chassis Module Interface

Generic Interface 
Configuration

Yes Yes Yes Yes Generic 
only

C12kM Management>Physical>Interface>Generic>
Configuration

ATM Interface 
Configuration

Yes Yes Yes Yes POS only C12kM Management>Physical>Interface>ATM> 
Configuration

Ethernet Interface 
Configuration

Yes Yes Yes Yes IP only C12kM Management>Physical>Interface>Ethernet>
Configuration

IP Configuration Yes Yes Yes Yes ATM only C12kM Management>Physical>Interface>IP>
Configuration

POS Interface 
Configuration

Yes Yes Yes Yes SONET 
only

C12kM Management>Physical>Interface>POS>
Configuration

APS Interface 
Configuration

Yes Yes Yes Yes SONET 
only

C12kM Management>Physical>Interface>POS>
APS Configuration
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Note The Interface Configuration windows cannot be opened when multiple objects are selected 
(the menu options to open the Interface Configuration windows are grayed out). Available 
menu options can be launched from a site object containing the required objects, when 
required.

Generic Interface Configuration
The Generic Interface Configuration window allows you to carry out part of the configuration on a 
selected interface. The Generic Interface Configuration window allows you to commission or 
decommission a selected interface.

Note Commissioning/decommissioning an interface is only available from the Generic Interface 
Configuration window.

The Generic Interface Configuration section covers the following areas:

• Viewing the Generic Interface Configuration Window

• Configuring and Commissioning a Generic Interface

• Decommissioning an Interface

• Generic Interface Configuration Window—Detailed Description

Viewing the Generic Interface Configuration Window
To view the Interface Configuration window, proceed as follows:

Step 1 Right click (on a relevant object icon in the Map Viewer window or from an object pick list) and select 
the C12kM Management>Physical> Interface>Generic>Configuration option. Refer to Table 8-1 on 
page 8-2 for information on which objects allow you to launch the Interface Configuration window. The 
Interface Configuration window appears with the Configuration tab displayed:

SRP Interface 
Configuration

Yes Yes Yes Yes SRP only C12kM Management>Physical>Interface>SRP> 
Configuration

SRP Side Configuration Yes Yes Yes Yes SRP Side 
only

C12kM 
Management>Physical>Interface>SRP>Side>
Configuration

Table 8-2 Launching the Interface Configuration Windows
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Figure 8-1 Interface Configuration Window—Configuration Tab

Step 2 Choose a Chassis, Module and Interface from the list boxes displayed at the left of the window.

Configuring and Commissioning a Generic Interface

Note Commissioning/decommissioning an interface is only available from the Generic Interface 
Configuration window.

To configure and commission a selected interface, follow these steps:

Step 1 Open the Generic Interface Configuration window. Refer to the “Viewing the Generic Interface 
Configuration Window” section on page 8-3 for further details.

Step 2 Choose a Chassis, Module and Interface from the lists displayed at the left of the window.

Step 3 Configure the parameters displayed in the Configuration tab, as required.

Step 4 Choose Commission when the status is Decommissioned. The status of the selected module appears at 
the bottom left-hand-corner of the window. The interface is now commissioned and its state changes to 
Commissioning and then to Normal or Errored state depending on whether the interface is active or 
not.

Step 5 Choose the Save icon to save any changes.
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Note You have now commissioned the selected interface. You should now proceed to the 
appropriate interface configuration window section in this chapter to configure specific 
interface attributes. For example, the ATM Interface Configuration window allows you to 
configure ATM specific attributes for a selected ATM interface.

Decommissioning an Interface
To decommission an interface, follow these steps:

Step 1 Open the Generic Interface Configuration window. Refer to the “Viewing the Generic Interface 
Configuration Window” section on page 8-3 for further details.

Step 2 Choose a Chassis, Module and Interface from the lists displayed at the left of the window.

Step 3 Choose Decommission when the Status is Normal. The status of the selected module appears at the 
bottom left-hand-corner of the window. The interface is now decommissioned and its state changes to 
Decommissioned.

Step 4 Choose the Save icon to save any changes.

Generic Interface Configuration Window—Detailed Description
The Interface Configuration window contains a single Configuration tab.

Configuration Tab

The Configuration tab (see Figure 8-1 on page 8-4) contains two areas: Configurable Parameters, and 
Actions.

Configurable Parameters

The Configurable Parameters area contains the following fields:

Alias—Name for the interface, as specified by the network manager.

Administration Status—Allows you to enable, disable or reset the module.

Link Up/Down Trap Enable—Allows you to choose whether link up/down traps should be generated for 
this interface.

Supplementary Information—Supplementary information.

Actions

The Actions area allows you to commission or decommission a selected interface.

Commission—Choose Commission to commission the selected interface.

Decommission—Choose Decommission to decommission the selected interface.
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ATM Interface Configuration
The ATM Interface Configuration window allows you to configure a selected ATM interface. The ATM 
Interface Configuration section covers the following areas:

• Viewing the ATM Interface Configuration Window 

• Configuring an ATM Interface

• ATM Interface Configuration Window—Detailed Description

Viewing the ATM Interface Configuration Window
To view the ATM Interface Configuration window, proceed as follows these steps:

Step 1 Right-click on a selected ATM line card or ATM interface, then choose C12kM Management>
Physical>Interface>ATM>Configuration.
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ATM Interface Configuration
The ATM Interface Configuration window appears:

Figure 8-2 ATM Interface Configuration Window—Configuration 1 Tab

Step 2 Choose a Chassis, Module, and ATM Interface from the lists displayed at the left of the window.

Configuring an ATM Interface
To configure an ATM Interface, follow these steps:

Step 1 Open the ATM Interface Configuration window. Refer to the “Viewing the ATM Interface Configuration 
Window” section on page 8-6 for further details.

Not applicable to C12kM
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Step 2 Choose a Chassis, Module, and ATM Interface from the lists displayed at the left of the window.

Step 3 Choose the Apply Profile option from the Edit menu and then choose the profile you wish to apply from 
the list displayed (if you are applying a profile). When a profile is applied, the attributes applied from 
the profile appear in blue.

Step 4 Edit the parameters displayed in the Configuration (1) tab, as required. Refer to the “ATM Interface 
Configuration Window—Detailed Description” section on page 8-8 for further details.

Note The parameters displayed in the Configuration (2) tab are not applicable to C12kM.

Step 5 Choose Save to save your configuration changes.

Step 6 Choose Close from the File menu to close the window.

Step 7 Proceed to the “Configuring and Commissioning a Generic Interface” section on page 8-4 to commission 
the interface, if required.

ATM Interface Configuration Window—Detailed Description
The ATM Interface Configuration window contains two tabs: Configuration (1) and Configuration (2).

Configuration (1) Tab

The Configuration (1) tab (see Figure 8-2) contains two areas: ATM Configuration, and ILMI 
Configuration.

ATM Configuration

The ATM Configuration area contains the following fields:

Neighbor IP Address—Not applicable to C12kM.

Neighbor Interface Name—Not applicable to C12kM.

Interface Type—Not applicable to C12kM.

UNI Type—Not applicable to C12kM.

ATM Interface Side—Not applicable to C12kM.

UNI Signalling Version—Version of UNI signalling that is currently being used on the interface. The 
appropriate value, either atmfUni3Dot0, atmfUni3Dot1, or atmfUni4Dot0, is used when the interface is 
an UNI or IISP interface. The value “not applicable” is used when the interface is a PNNI interface or 
when signalling is disabled. Setting this variable to a value of not applicable is not allowed. To modify 
this field, the interface admin status has to be down and the interface Ilmi auto configuration disabled.

SVC UPC Intent—Not applicable to C12kM.

Signalling Admin Status—Not applicable to C12kM.

Address Type—Not applicable to C12kM.

Well-known VC Mode—Not applicable to C12kM.
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Loopback—The following options are available:

Enabled—Packets are transmitted back to the source to test the interface functionality and ensure 
that packets transmitted through the interface reach the destination without data loss.

Disabled—Restricts connection status (success or failure) messages from being received.

Diagnostic—Transmit data stream is looped to the transmit direction.

Transmit Queue Limit—Not applicable to C12kM.

Maximum VPCs—Not applicable to C12kM.

Maximum Active VPI Bits—Not applicable to C12kM.

Maximum VCCs—Maximum number of VCCs (PVCs and SVCs) supported at this interface.

Maximum Active VCI Bits—Not applicable to C12kM.

Number of VCs per VP—Set the number of virtual channel per virtual path.

Clock Source—Source of the clock.

NSAP (Network Service Access Point) Address—Specify the NSAP address.

ILMI Configuration

The ILMI Configuration area contains the following fields:

Keepalive Time—Amount of time that should elapse between successive ILMI keepalive messages sent 
on this interface. A value of 0 disables ILMI keepalive messages on this interface.

VPI Value—Not applicable to C12kM.

Auto-Configuration—Enable or disable the ILMI link and interface type determination. The 
configuration takes effect only on the next interface restart.

VCI Value—Not applicable to C12kM.

Address Registration—Enable or disable ILMI address registration on this interface. The configuration 
takes effect only on the next interface restart.

Configuration—Enable or disable ILMI configuration on this interface. The configuration takes effect 
only on the next interface restart. Disabling this object will also disable address registration, 
auto-configuration, and keepalive time.

Configuration 2 Tab

The Configuration (2) tab is not applicable to C12kM.

Ethernet Interface Configuration
The Ethernet Interface Configuration window allows you to configure Ethernet fields, such as loopback, 
keepalive period, and MAC address.

The Ethernet Interface Configuration section covers the following areas:

• Viewing the Ethernet Interface Configuration Window

• Configuring an Ethernet Interface

• Ethernet Interface Configuration Window—Detailed Description
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Viewing the Ethernet Interface Configuration Window
To view the Ethernet Interface Configuration window, proceed as follows:

Step 1 Right-click on a selected Ethernet line card or an Ethernet interface, then choose C12kM Management> 
Physical>Interface>Ethernet>Configuration. The Ethernet Interface Configuration window appears:

Figure 8-3 Ethernet Interface Configuration Window—Configuration Tab

Step 2 Choose a Chassis, Module, and Ethernet Interface from the lists displayed at the left of the window.
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Configuring an Ethernet Interface
To configure an Ethernet Interface, follow these steps:

Step 1 Open the Ethernet Interface Configuration window. Refer to the “Viewing the Ethernet Interface 
Configuration Window” section on page 8-10 for further details.

Step 2 Choose a Chassis, Module, and Ethernet Interface from the lists displayed at the left of the window.

Step 3 Choose the Apply Profile option from the Edit menu and then select the profile you wish to apply from 
the list displayed (if you are applying a profile). When a profile is applied, the attributes applied from 
the profile appear in blue.

Step 4 Edit the parameters displayed in the Configuration tab, as required. Refer to the “Ethernet Interface 
Configuration Window—Detailed Description” section on page 8-12 for further details.

Step 5 Choose the HSRP Parameters tab.

Figure 8-4 Ethernet Interface Configuration Window—HSRP Parameters Tab
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Step 6 Configure the fields in the HSRP Parameters tab, as required. For further information on the fields 
displayed in this window, refer to the “Ethernet Interface Configuration Window—Detailed Description” 
section on page 8-12.

Step 7 Choose Save to save your configuration changes.

Step 8 Choose Close from the File menu to close the window.

Step 9 Proceed to the “Configuring and Commissioning a Generic Interface” section on page 8-4 to commission 
the interface, if required.

Ethernet Interface Configuration Window—Detailed Description
The Ethernet Interface Configuration window displays two tabs: Configuration, and HSRP Parameters.

Configuration Tab

The Configuration tab (see Figure 8-3 on page 8-10) contains a single General area.

General

The General area displays the following fields:

Loopback—The following options are available:

Internal—No cable is needed to connect the input and output ports. The data is looped back within 
the device itself. Applicable only for Gigabit and Fast Ethernet interfaces.

External—Input and output ports are physically connected by a cable to simulate a loopback. When 
data is transmitted, it travels through the output port and enters the device through the input port. 
Applicable only for Gigabit and Fast Ethernet interfaces.

Enabled—Packets are transmitted back to the source to test the interface functionality and ensure 
that packets transmitted through the interface reach the destination. Applicable only for GRP 
Ethernet interfaces.

Caution When the loopback for the Ethernet interface in the GRP is enabled, the Ethernet 
communication link to the Cisco 12000 series internet router will be lost.

Note If the communication link to the Cisco 12000 series internet router is lost it cannot be switched on 
again from Cisco EMF, and access to the Cisco 12000 series internet router is required before the link 
can be re-enabled.

Disabled—Disables switches loopback off for GRP, Fast and Gigabit Ethernet interfaces.

Keepalive Period—Displays set the keepalive period. The system sends packets to know if the interface 
or the network is up for routing packets. By default it is 10 seconds.

MAC Address—Enter the MAC address of the interface (each interface has a unique MAC address).

Caution Setting the MAC address on GRP Ethernet could result in a loss of communications.
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HSRP Parameters Tab

The HSRP Parameters tab (see Figure 8-4 on page 8-11) displays a Configured Group Numbers field and 
an HSRP Parameters area.

Configured Group Numbers—List of configured HSRP group numbers.

HSRP Parameters

The HSRP Parameters area contains the following fields:

Group Number—Group number on the interface for which HSRP is being activated. The default is zero.

Standby Priority—Enable or disable the priority for the HSRP interface. Possible values are as follows:

Enabled—When the current interface fails, it automatically switches to the standby interface.

Disabled—When the current interface fails, it does not switch to a standby interface.

Standby Authentication—Enable or disable the standby authentication string. Options available are:

Enabled—Checks for an authentication string set and allows you to configure the interface on 
presence of the set string.

Disabled—Does not check for an authentication string.

Standby Hello Time—(in seconds) Can be an integer from 1 to 255. The default is 3 seconds.

Standby Preempt—Standby router waits for the set time and takes over as active router if the current 
router fails or does not respond to the packets sent.

IP Address—IP address of the hot standby router interface.

Priority—Priority value that prioritizes a potential hot standby router. The range is 1 to 255; the default 
is 100. 

Authentication String—Serves as check to avoid any damage to the interface. It can be up to eight 
characters in length. The default string is “cisco.”

Standby Hold Time—Set the time in seconds before the active or standby router is declared to be down. 
This is an integer from 1 to 255. The default is 10 seconds.

IP Configuration
The IP Configuration window allows you to configure generic IP fields (for example, IP address, and 
interface state).

The IP Configuration section covers the following areas:

• Viewing the IP Configuration Window

• Configuring an IP Interface

• IP Configuration Window—Detailed Description
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Viewing the IP Configuration Window
To view the IP Configuration window, proceed as follows:

Step 1 Right-click a selected IP line card or IP interface, then choose C12kM Management>Physical> 
Interface>IP>Configuration. The IP Configuration window appears, with the Generic Parameters tab 
displayed.

Figure 8-5 IP Configuration Window—Generic Parameters Tab

Step 2 Choose a Chassis, Module, and IP Interface from the lists displayed at the left of the window. 
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Configuring an IP Interface
To configure an IP Interface, follow these steps:

Step 1 Open the IP Interface Configuration window. Refer to the “Viewing the IP Configuration Window” 
section on page 8-14 for further details.

Step 2 Choose a Chassis, Module, and IP Interface from the lists displayed at the left of the window.

Step 3 Choose the Apply Profile option from the Edit menu and then choose the profile you wish to apply from 
the list displayed (if you are applying a profile). When a profile is applied, the attributes applied from 
the profile appear in blue.

Step 4 Configure the parameters displayed in the Generic Parameters tab, as required. Refer to the “IP 
Configuration Window—Detailed Description” section on page 8-15 for further details.

Step 5 Choose Save to save your configuration changes.

Step 6 Choose Close from the File menu to close the window.

Step 7 Proceed to the “Configuring and Commissioning a Generic Interface” section on page 8-4 to commission 
the interface, if required.

IP Configuration Window—Detailed Description
The IP Configuration window (see Figure 8-1) contains two tabs: Generic Parameters and HSRP 
Parameters.

Generic Parameters Tab

The Generic Parameters tab contains a single Generic Parameters area.

Generic Parameters

The Generic Parameters area contains the following fields:

IP Address—IP address for the selected chassis.

Subnet Mask—Address mask for the selected chassis.

Maximum Transmission Unit—Maximum packet size, in bytes, that the selected interface can handle.

Interface State—Choose the interface state to be used from the drop down list.

Cisco Discovery Protocol (CDP)—Enable or disable CDP on the chassis. CDP allows a device to 
advertise its existence to other devices and receive information about other devices on the same LAN or 
on the remote side of a WAN.

IP Multicast Fast Switching—Enable or disable IP Multicast Fast Switching on the chassis.

POS Interface Configuration
The POS Interface Configuration window allows you to configure a selected POS Interface.
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The POS Interface Configuration section covers the following areas:

• Viewing the POS Interface Configuration Window

• Configuring a POS Interface

• POS Interface Configuration Window—Detailed Description

Viewing the POS Interface Configuration Window
To view the POS Interface Configuration window, proceed as follows:

Step 1 Right-click on a selected POS line card or POS interface, then choose C12kM Management>Physical> 
Interface>POS>Configuration. The POS Interface Configuration window appears:

Figure 8-6 POS Interface Configuration Window—POS Config Tab
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Step 2 Choose a Chassis, Module, and POS Interface from the lists displayed at the left of the window.

Configuring a POS Interface
To configure a POS Interface, follow these steps:

Step 1 Open the POS Interface Configuration window. Refer to the “Viewing the POS Interface Configuration 
Window” section on page 8-16 for further details.

Step 2 Choose a Chassis, Module, and POS Interface from the lists displayed at the left of the window.

Step 3 Choose the Apply Profile option from the Edit menu and then choose the profile you wish to apply from 
the list displayed (if you are applying a profile). When a profile is applied, the attributes applied from 
the profile appear in blue.

Step 4 Configure the parameters displayed in the POS Config tab, as required. Refer to the “POS Interface 
Configuration Window—Detailed Description” section on page 8-17 for further details.

Step 5 Choose Save to save your configuration changes.

Step 6 Choose Close from the File menu to close the window.

Step 7 Proceed to the “Configuring and Commissioning a Generic Interface” section on page 8-4 to commission 
the interface, if required.

POS Interface Configuration Window—Detailed Description
The POS Interface Configuration window contains one tab, POS Config.

POS Config Tab

The POS Config tab (see Figure 8-6) contains four areas: General, SONET Overhead, Alarm Reporting 
and Threshold, and Alarm Reporting.

General

The General area contains the following fields:

POS SPE Scrambling—Enable or disable POS SPE scrambling. Scrambling is similar to encrypting. The 
enabled option is selected by default.

Loopback—Choose the loopback mode. The following options are available:

Enabled—Packets are transmitted back to the source to test the interface functionality and ensure 
that packets transmitted through the interface reach the destination without data loss.

Disabled—Restricts connection status (success or failure) messages from being received.

Clock Source—Choose a clock source from the available options. There is a clock in every device, which 
measures the speed of the device. This can either be internal (within the device) or line (network clock).

Keepalive—Set keepalive period. The system sends packets to know if the interface or the network is up 
for routing packets. By default it is 10 seconds.
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POS Framing—Choose the type of POS framing.

Encapsulation—Select HDLC, PPP or Frame-Relay encapsulation type.

Cyclic Redundancy Check—Choose an option for cyclic redundancy check. Cyclic redundancy checks 
consist of 16 or 32 bit verification code which have to be same at both the transmitting and receiving 
ends to ensure the packets sent are received in full without loss of data. By default, it is 32 bit code.

SONET Overhead

The Sonet Overhead area contains the following fields:

Path Signal Identifier—Permissible values range from 0 to 255.

Payload Pointer Byte—Choose an option for payload pointer byte from the drop down menu. 
Permissible values range from 0 to 3.

Section Trace Byte—Permissible values range from 0 to 255.

Alarm Reporting & Threshold

The Alarm Reporting & Threshold area allows you to configure and enable alarms generated by the 
system. This area contains the following fields:

B1 BER Threshold Crossing Alarm (TCA)—Set threshold limits for the system to prompt appropriate 
B1 BER TCA threshold alarm messages. The field beside this value displays the threshold for the B1 
BER TCA.

B2 BER Threshold Crossing Alarm (TCA)—Set threshold limits for the system to prompt appropriate 
B2 BER TCA threshold alarm messages. The field beside this value displays the threshold for the B2 
BER TCA.

B3 BER Threshold Crossing Alarm (TCA)—Set threshold limits for the system to prompt appropriate 
B3 BER TCA threshold alarm messages. The field beside this value displays the threshold for the B3 
BER TCA.

Signal Degrade BER—Set threshold limits for the system to prompt appropriate signal degrade BER 
threshold alarm messages. The field beside this value displays the threshold for the signal degrade BER.

Signal Fail BER—Set threshold limits for the system to prompt appropriate signal fail BER threshold 
alarm messages. The field beside this value displays the threshold for the signal fail BER.

Alarm Reporting

The Alarm Reporting area contains the following fields:

Path Remote Defect Indication Errors—Enable or disable the path remote defect indication errors alarm 
messages.

Line Remote Defect Indication Errors—Enable or disable the line remote defect indication errors alarm 
messages.

Line Alarm Indication Signal Errors—Enable or disable the line alarm indication signal errors alarm 
messages.

Receive Data Out of Lock Errors—Enable or disable the Receive data output of lock errors alarm 
messages.

Path Alarm Indication Signal Errors—Enable or disable the path alarm indication signal errors alarm 
messages.

Section Loss of Signal Errors—Enable or disable the section loss of signal errors alarm messages.
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LAIS on Interface Shutdown—Enable or disable the LAIS on interface shutdown alarm messages.

Section Loss of Frame Errors—Enable or disable the section loss of frame errors alarm messages.

Path Loss of Pointer Errors—Enable or disable the path loss of pointer errors alarm messages.

APS Interface Configuration
The APS Interface Configuration window allows you to configure a selected APS Interface. APS 
Configuration allows you to remove APS (Automatic Protection Switching)

Note It is recommended that only a system administrator have access to the APS Configuration 
window.

The APS Interface Configuration section covers the following areas:

• Viewing the APS Configuration Window

• APS Configuration Window—Detailed Description
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Viewing the APS Configuration Window
To view the APS Configuration window, proceed as follows:

Step 1 Right-click on a selected POS line card or POS interface, then choose C12kM Management>Physical> 
Interface>POS>APS Configuration. The APS Configuration window appears:

Figure 8-7 APS Configuration Window—APS Tab

Step 2 Choose a Chassis, Module, and POS Interface from the lists displayed at the left of the window.

The APS Configuration window allows you to:

• Add a working interface

• Remove a working interface

• Add a protected interface

• Remove a protected interface

Note A working and a protected interface cannot be configured at the same time.
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Adding a Working Interface

To add a working interface, proceed as follows:

Step 1 Choose a Chassis, Module, and POS Interface from the list boxes at the left of the window.

Step 2 Choose the Working button.

Step 3 Enter appropriate text in the Authentication and Group fields (for details on these fields, refer to the 
“APS Configuration Window—Detailed Description” section on page 8-22).

Step 4 Choose Save.

Removing a Working Interface

To remove a working interface, proceed as follows:

Step 1 Choose a Chassis, Module, and POS Interface from the list boxes displayed at the left of the window.

Step 2 The Working button for the selected interface should already be selected. Choose the Working button 
to deactivate.

Step 3 Choose Save.

Adding a Protected Interface

To add a protected interface, proceed as follows:

Step 1 Choose a Chassis, Module, and POS Interface from the list boxes displayed at the left of the window.

Step 2 Choose the Protect button.

Step 3 Enter appropriate text in all fields (for details on these fields, refer to the “APS Configuration 
Window—Detailed Description” section on page 8-22).

Step 4 Choose Save.

Removing a Protected Interface

To remove a protected interface, proceed as follows:

Step 1 Choose a Chassis, Module, and POS Interface from the list boxes displayed at the left of the window.

Step 2 The Protect button for the selected interface should already be selected. Choose the Protect button to 
deactivate.

Step 3 Choose Save.
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APS Configuration Window—Detailed Description
The APS Configuration window displays a single APS tab.

APS Tab

The APS tab (see Figure 8-7 on page 8-20) displays a single APS Interface area.

APS Interface

The APS Interface area contains the following buttons and fields:

Working—Select this button to establish a working interface.

Protect—Select this button to establish a protected interface.

Authentication—Allows you to set values, which serve as check on entry of packets (information) sent 
over the network. This shields the system from any damage on account of data download.

Hello Time—Set time for the working interface to report on its status to the protected interface. The 
interface is bidirectional by default.

Hold Time—Set the time for protected interface (standby system) to wait for the working interface to 
communicate on its status. On expiry of time set, the protected interface takes over as the working or the 
active interface.

Revert Mode—Choose “Revertive” to enable automatic switch-over from the protected interface to the 
working interface after the working interface becomes available.

Direction Mode—Choose the interface direction mode. Options available are:

Unidirectional—Packets are received and transmitted independently.

Bidirectional—Packets are transmitted and received in pairs.

Group—Has a value of 1 for each interface established.

Interconnect IP Address—IP Address of the router that contains the working interface.

Lockout—Set the value to yes or no. Yes prevents the working interface from switching to the protected 
interface. 

Revert Time—Set the revert time, the system reverting automatically to the working interface from 
protected interface (standby system) once the working interface is online.

Switch to Circuit—Set the value for the circuit to switch to protected interface when working interface 
fails. The options are: manual, force, or none.
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SRP Interface Configuration 
The SRP Interface Configuration window allows you to configure a selected SRP Interface. The SRP 
Interface Configuration section covers the following areas:

• Viewing the SRP Interface Configuration Attributes

• Configuring a SRP Interface

• SRP Interface Configuration Window—Detailed Description

Viewing the SRP Interface Configuration Attributes
To view the attributes in the SRP Interface Configuration window, proceed as follows:

Step 1 Choose the C12kM Management>Physical>Interface>SRP>Configuration option from a relevant 
object icon to launch the SRP Configuration window. Refer to Table 8-2 on page 8-2 for information on 
which objects allow you to launch the SRP Interface Configuration window.

Figure 8-8 SRP Interface Configuration Window
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Step 2 Choose a Chassis, Module, and SRP Interface from the lists displayed at the left side of the window to 
view the configuration details of the SRP interface.

Configuring a SRP Interface 
To configure a SRP Interface, proceed as follows: 

Step 1 Launch the SRP Interface Configuration window. Refer to Table 8-2 on page 8-2 for information on 
which objects allow you to launch the SRP Interface Configuration window.

Step 2 Choose a Chassis, Module, and SRP Interface from the lists displayed at the left side of the window.

Step 3 Edit the parameters displayed in the Configuration tab, as required. Refer to the “SRP Interface 
Configuration Window—Detailed Description” section for further details.

Step 4 Choose Save to save your configuration changes.

SRP Interface Configuration Window—Detailed Description
The SRP Interface Configuration window contains the two panels: General and IPS

General 

Bandwidth – Allows you to configure the bandwidth of a SRP interface

Topology Timer – Allows you to configure the time (in seconds) that determines the interval to send the 
topology discovery packets to the ring

Priority Threshold – Allows you to configure the incoming packet priority limit

Tx Traffic Rate – High – Allows you to configure the high rate limit of outgoing traffic, in megabits per 
second

Tx Traffic Rate – Low – Allows you to configure the low rate limit of outgoing traffic, in megabits per 
second 

Note The Priority Threshold, Tx Traffic Rate – High, Tx Traffic Rate – Low parameters are 
applicable only to OC-48 SRP Interfaces. The user-defined values will not be accepted for 
these parameters and will always be set to default values.

IPS 

IPS Lock – Allows you to configure the boolean flag to indicate node LockedOut of protection state.

IPS Timer – Allows you to configure the frequency at which the IPS messages are to be displayed, in 
seconds

IPS Wait To Restore Timer – Allows you to configure the time interval in seconds, to remain in the wrap 
state, after the cause of a wrap is removed.
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SRP Side Configuration
The SRP Side Configuration window allows you to configure a selected SRP Side. The SRP Side 
Configuration section covers the following areas:

• Viewing the SRP Side Configuration Attributes

• Configuring a SRP Side

• SRP Side Configuration Window—Detailed Description

Viewing the SRP Side Configuration Attributes
To view the SRP Side Configuration window, proceed as follows:

Step 1 Choose the C12kM Management>Physical>Interface>SRP>Side>Configuration option from a 
relevant object icon to launch the SRP Side Configuration window. Refer to Table 8-2 on page 8-2 for 
information on which objects allow you to launch the SRP Side Configuration window.

Figure 8-9 Figure: SRP Side Configuration Window
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Step 2 Choose a Chassis, Module, SRP Interface and SRP Side from the lists displayed at the left of the 
window to view the configuration details of the SRP Side.

Configuring a SRP Side
To configure a SRP Side, proceed as follows: 

Step 1 Launch the SRP Side Configuration window. Refer to Table 8-2 on page 8-2 for information on which 
objects allow you to launch the SRP Side Configuration window.

Step 2 Choose a Chassis, Module, SRP Interface and SRP Side from the lists displayed at the left side of the 
window.

Step 3 Edit the parameters displayed in the General and Alarm tabs, as required. Refer to the “SRP Side 
Configuration Window—Detailed Description” section for further details.

Step 4 Choose Save to save your configuration changes.

SRP Side Configuration Window—Detailed Description
The SRP Side Configuration window has two tabs namely: General, and Alarms

General Tab

The General tab displays four panels: General, SONET Overhead, IPS SONET and Action.

General

The General panel allows you to configure the following information:

Clock Source — Allows you to configure the clock source from available options. It indicates the mode 
of the SRP clock source for SRP Side profile, which measures the speed of the device. This can either 
be internal (within the device) or Line (the network clock).

Loopback — Allows you to configure the loopback mode. It indicates the loopback mode for the SRP 
Side profile. The available options are: Disabled, Internal or Line

Framing — Allows you to configure SDH or SONET type framing. It indicates the framing mode of the 
side profile.

IPS Management Request Mode — Allows you to configure the IPS management request mode for the 
side profile. The available options are: noRequest, forced-switch, manual-switch, waitToRestore, 
signalDegrade, and signalFail.

Note The waitToRestore, signalDegrade and SignalFail modes cannot be set for the Interface, 
however the user can view the values as they are read-only values.
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SONET Overhead

Path Signal Identifier – Allow you to configure the path signal identifier. The permissible values range 
from 0 to 255.

Section Trace Byte – Allows you to configure the section trace byte. The permissible values are 0 to 255.

Note If the device has pre-defined default values for the Path Signal Identifier and Section Trace 
Byte parameters, the same values are displayed in this area when the profile is created.

IPS SONET 

Protected – Allows you to configure the Protected mode. The available options are: enable and disable

SD Threshold <3-9> (in 10e-) – Allows you to select the Signal Degrade threshold value in 10e-, 
between 3-9

SF Threshold <3-9> (in 10e-) – Allows you to select the Signal Fail BER threshold value in 10e-, 
between 3-9

Alarms Tab

The Alarms tab displays two panels: Reporting & Threshold, and Reporting

Reporting and Threshold

The Reporting & Threshold panel allows you to configure the following information:

B1 BER Threshold Crossing Alarm – Allows you to enable/disable threshold limits for the system to 
prompt appropriate B1 BER Threshold alarm messages. (3-9)

B2 BER Threshold Crossing Alarm – Allows you to enable/disable threshold limits for the system to 
prompt appropriate B2 BER Threshold alarm messages.

B3 BER Threshold Crossing Alarm – Allows you to enable/disable threshold limits for the system to 
prompt appropriate B3 BER Threshold alarm messages.

Signal Degrade BER – Allows you to enable/disable threshold limits for the system to prompt 
appropriate Signal Degrade BER Threshold alarm messages

Signal Fail BER – Allows you to enable/disable threshold limits for the system to prompt appropriate 
Signal Fail BER Threshold alarm messages

B1 Threshold <3-9> (in 10e-) – Displays B1 BER threshold value in 10e-, between 3-9

B2 Threshold <3-9> (in 10e-) – Displays B2 BER threshold value in 10e-, between 3-9

B3 Threshold <3-9> (in 10e-) – Displays B3 BER threshold value in 10e-, between 3-9

SD Threshold <3-9> (in 10e-) – Displays Signal Degrade threshold value in 10e-, between 3-9

SF Threshold <3-9> (in 10e-) – Displays Signal Fail BER threshold value in 10e-, between 3-9

Reporting

Section Loss of Frame Errors – Allows you to enable/disable the panel loss of panel errors alarm 
messages.

Section Loss of Signal Errors – Allows you to enable/disable the panel loss of signal errors alarm 
messages.
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Line Alarm Indication Signal Errors – Allows you to enable/disable the line alarm indication signal 
errors alarm messages.

Line Remote Defect Indication Errors – Allows you to enable/disable the line remote defect indication 
errors alarm messages.

Path Loss of Pointer Errors – Allows you to enable/disable the path loss of pointer errors alarm 
messages.

Path Alarm Indication Signal Errors – Allows you to enable/disable the path alarm indication signal 
errors alarm messages.

Path Remote Defect Indication Errors – Allows you to enable/disable the path remote defect indication 
errors alarm messages. 
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